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Materials & Staging Tutorial 

 

This tutorial will demonstrate the use of multiple materials and staging 
in RS2, using material and stage boundaries. The model represents a 
longhole stope in an orebody which has different properties than the 
surrounding rock mass. 

The model will consist of a total of four stages – the stope will be 
excavated in the first three stages, and will be backfilled in the fourth 
stage. Support (cables) will also be installed from the access drifts to the 
hangingwall. Support installation is covered in more detail in the RS2 
Support tutorial. 

The finished product of this tutorial can be found in the Tutorial 02 
Materials and Staging.fez file. All tutorial files installed with RS2 9.0 
can be accessed by selecting File > Recent Folders > Tutorials Folder 
from the RS2 main menu. 

Model 

If you have not already done so, run the RS2 Model program by double-
clicking on the RS2 icon in your installation folder. Or from the Start 
menu, select Programs  Rocscience  RS2 9.0  RS2. 
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Project Settings 

Whenever we are creating a staged model, the first thing we should do is 
define the number of stages in Project Settings, since this affects 
subsequent modeling options. 

Select: Analysis  Project Settings 

First select the General tab and make sure that the Units option is set 
to Metric, stress as MPa. This determines the units of length, force, 
stress and unit weight used in the analysis. 

Select the Stages tab. Set the Number of Stages = 4, to create a total of 
four stages. Change the name of the fourth stage to backfill, as shown 
below. 

 

Select the Project Summary tab and enter “Materials and Staging 
Tutorial” as the Project Title. 

Do not change any other settings in the dialog. Select OK. 

Entering Boundaries 

Next we will define the stope and the three access drifts using 
Excavation boundaries. Select the Geometry workflow tab, then select 
Add Excavation from the toolbar or the Boundaries menu. 

Select: Boundaries  Add Excavation 

Enter vertex [t=table,i=circle,esc=cancel]: 35 80 
Enter vertex [...]: 15 80 
Enter vertex [...]: 10 60 
Enter vertex [...]: 5 40 
Enter vertex [...]: 0 20 



 Materials and Staging Tutorial 2-3  

RS2 v.9.0 Tutorial Manual 

Enter vertex [...]:   20 20 
Enter vertex [...]: 25 40 
Enter vertex [...]: 30 60 
Enter vertex [...,c=close,esc=cancel]: c 

Press F2 to Zoom All, to center the excavation in the view. 

Select: Boundaries  Add Excavation 

Enter vertex [t=table,i=circle,esc=cancel]: 0 80 
Enter vertex [...]: -2.5 80 
Enter vertex [...]: -2.5 77.5 
Enter vertex [...]: 0 77.5 
Enter vertex [...,c=close,esc=cancel]: c 

Select: Boundaries  Add Excavation 

Enter vertex [t=table,i=circle,esc=cancel]: -5 60 
Enter vertex [...]: -7.5 60 
Enter vertex [...]: -7.5 57.5 
Enter vertex [...]: -5 57.5 
Enter vertex [...,c=close,esc=cancel]: c 

Select: Boundaries  Add Excavation 

Enter vertex [t=table,i=circle,esc=cancel]: -10 40 
Enter vertex [...]: -12.5 40 
Enter vertex [...]: -12.5 37.5 
Enter vertex [...]: -10 37.5 
Enter vertex [...,c=close,esc=cancel]: c 

Now let’s add the two stage boundaries so that the stope can be 
excavated in three stages. Stage boundaries can be used within 
excavations, for defining intermediate excavation boundaries. 

Select: Boundaries  Add Stage 

Before we start, right-click the mouse and make sure the Snap option is 
enabled, so that we can snap the stage boundary vertices to the existing 
excavation vertices. 

Enter vertex [t=table,i=circle,esc=cancel]: use the mouse to 
click on the excavation vertex at 10 60 
Enter vertex [...]: use the mouse to click on the excavation 
vertex at 30 60 
Enter vertex [...,enter=done,esc=cancel]: right-click and 
select Done 

Notice that when you are in Snap mode, if you hover the cursor over a 
vertex, the cursor changes to a circle, to indicate that you will snap 
exactly to a vertex, when you click the mouse. 
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Select: Boundaries  Add Stage 

Enter vertex [t=table,i=circle,esc=cancel]: use the mouse to 
click on the excavation vertex at 5 40 
Enter vertex [...]: use the mouse to click on the excavation 
vertex at 25 40 
Enter vertex [...,enter=done,esc=cancel]: right-click and 
select Done 

Since we planned ahead and added extra vertices to the stope where the 
stage boundaries would be, all we had to do was snap to these vertices to 
add the stage boundaries. 

If the stage boundary vertices were not there, we could have still added 
the stage boundaries using the automatic boundary intersection 
capability of RS2, which would automatically add the required vertices. 
This is demonstrated below with the material boundaries. 

Next, let’s add the external boundary. 

Select: Boundaries  Add External 

 

We will use the default settings of Boundary Type and Expansion Factor 
so just select OK, and the external boundary will be automatically 
created. 

We will now add the material boundaries, which will define the rest of 
the orebody outside of the excavation. 

Select: Boundaries  Add Material 

You should still be in Snap mode. 

Enter vertex [t=table,i=circle,esc=cancel]: use the mouse to 
click on the excavation vertex at 15 80 
Enter vertex [...]: enter the point 55 240 in the prompt line 
Enter vertex [...,enter=done,esc=cancel]: press Enter 

Select: Boundaries  Add Material 
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Enter vertex [t=table,i=circle,esc=cancel]: use the mouse to 
click on the excavation vertex at 35 80 
Enter vertex [...]: enter the point 75 240 in the prompt line 
Enter vertex [...,enter=done,esc=cancel]: press Enter 

Select: Boundaries  Add Material 

Enter vertex [t=table,i=circle,esc=cancel]: use the mouse to 
click on the excavation vertex at 0 20 
Enter vertex [...]: enter the point -40 -140 in the prompt line 
Enter vertex [...,enter=done,esc=cancel]: press Enter 

Select: Boundaries  Add Material 

Enter vertex [t=table,i=circle,esc=cancel]: use the mouse to 
click on the excavation vertex at 20 20 
Enter vertex [...]: enter the point –20 -140 in the prompt line 
Enter vertex [...,enter=done,esc=cancel]: press Enter 

You have just added four material boundaries, representing a 
continuation of the orebody above and below the excavation. Note the 
following important point: 

The second point you entered for each of the four material boundaries was 
actually slightly outside of the external boundary. RS2 automatically 
intersected these lines with the external boundary, and added new 
vertices. This capability of RS2 is called ‘automatic boundary 
intersection’, and is useful whenever exact intersection points are not 
known, or whenever new boundaries cross existing boundaries where 
vertices were not previously defined. 

Since we knew the slope of the material boundaries but not the exact 
intersection with the external boundary, we just picked a point outside of 
the external boundary and RS2 calculated the exact intersection. 

We are finished defining the boundaries for this model, so let’s move on 
to the meshing. 

Meshing 

For this model, we will use the default Mesh Setup parameters. Since we 
do not need to customize the discretization of the boundaries, we will use 
the Discretize and Mesh shortcut, which automatically discretizes the 
boundaries and generates the mesh with a single mouse click. 

Select the Mesh workflow tab, then select Discretize and Mesh from 
the toolbar or the Mesh menu. 

Select: Mesh  Discretize & Mesh 

The mesh will be generated and the status bar will show the number of 
discretizations, elements and nodes in the mesh. 
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NODES = 7115 ELEMENTS = 3498 

The mesh appears satisfactory, so we will proceed with the modeling. 
(NOTE: the mesh quality can always be inspected with the Show Mesh 
Quality option in the Mesh menu. This is left as an optional exercise to 
explore after completing this tutorial, and is described in the RS2 Help 
system). 

Boundary Conditions 

For this tutorial, no boundary conditions need to be specified by the user. 
The default boundary condition will therefore be in effect, which is a 
fixed (i.e. zero displacement) condition for the external boundary. 

Support 

We will support the hangingwall of the stope with cable bolts installed 
from the access drifts. To save some time, we will import the bolt 
geometry from a DXF file, since support installation (pattern bolting and 
liners) is covered in more detail in the RS2 Support Tutorial. 

Select: File  Import  Import DXF 

Navigate to the RS2 9.0 Examples > Tutorials folder and open the 
Tutorial 02 Bolts.dxf file. NOTE: the file path depends on your 
operating system, for example: 

 Windows 7/8: C:\Users\Public\Public 
Documents\Rocscience\RS2 9.0 Examples\Tutorials 

 Windows XP: C:\Documents and Settings\All Users\Shared 
Documents\Rocscience\RS2 9.0 Examples\Tutorials 

The dialog should show a preview of the bolts in the DXF file. Select OK. 
Twelve cables (thick blue lines) should now be installed from the access 
drifts to the hangingwall. Normally, these bolts would be installed using 
the Add Bolt option, but that is left as an optional exercise to 
experiment with after completing this tutorial. 

To get a better look at the bolts: 

Select: View  Zoom  Zoom Excavation 

When finished, press F2 to Zoom All. 
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Field Stress 

For this tutorial we will use a constant field stress. A constant field stress 
is a reasonable assumption when excavations are relatively deep (i.e. not 
near the ground surface). For surface or near surface excavations, gravity 
field stress is more appropriate, this is covered in later tutorials. 

Select the Loads & Restraints workflow tab, then select Field Stress 
from the toolbar or the Loading menu. 

Select: Loading  Field Stress 

 

In the Field Stress dialog, enter a constant field stress of Sigma 1 = 30 
MPa and Sigma 3 = Sigma Z = 20. Leave the Angle = 0 degrees. Select 
OK.  

Notice that the stress block indicates the relative magnitude and 
direction of the in-plane principal stresses you entered. The angle in this 
case is zero, so Sigma 1 is horizontal. 

Properties 

This is where most of the ‘action’ will be in this tutorial, as far as the 
modeling is concerned. First we will define the material properties 
(rockmass, ore, and backfill) and the bolt properties, and then we will 
assign these properties and the staging sequence to the various elements 
of our model. 

Select the Materials & Staging workflow tab. 

Define Material Properties 

Select: Properties  Define Materials 

With the first material selected in the list at the left of the Define 
Material Properties dialog, enter the rock mass properties. 
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Enter Name = rock mass. Under the Strength tab enter the following 
parameters: 

 Failure Criterion = Generalized Hoek-Brown 
 Material Type = Plastic 
 Comp. Strength = 110 
 mb (peak) = 10 
 s (peak) = 0.05 
 a (peak) = 0.5 
 Dilation = 2.5 
 mb (residual) = 10 
 s (residual) = 0.02 
 a (residual) = 0.5 

Under the Stiffness tab enter: 

 Young’s Modulus = 64000 
 Poisson’s Ratio = 0.25 

 

Select the second material in the list, and enter the ore properties. 

Enter Name = ore. Under the Strength tab enter the following 
parameters: 

 



 Materials and Staging Tutorial 2-9  

RS2 v.9.0 Tutorial Manual 

 

Under the Stiffness tab enter: 

 

Select the third material in the list and enter the backfill properties. 
Enter Name = backfill, Initial Element Loading = Body Force Only, Unit 
Weight = 0.023. Under the Strength tab enter the following parameters: 

 

Under the Stiffness tab enter: 

 



 Materials and Staging Tutorial 2-10  

RS2 v.9.0 Tutorial Manual 

Notice the properties we gave to the ore and the backfill. The orebody has 
a significantly lower stiffness and strength than the rockmass. The 
backfill has very low stiffness and strength. In addition, the ‘Initial 
Element Loading’ for the backfill was toggled to ‘Body Force Only’ – the 
field stress component of initial element loading for a backfill material 
should always be zero. ‘Body Force Only’ implies that the initial element 
loading is due to self-weight only. The unit weight of a material must be 
defined when the initial element loading includes body force. 

We are finished defining the material properties. Select OK to close the 
Define Material Properties dialog, and we will now define the bolt 
properties. 

Define Bolt Properties 

Select: Properties  Define Bolts 

 

Select the first bolt type from the list at the left of the dialog. Enter 
Name = cables. Select Bolt Type = Plain Strand Cable. Enter Out-of-
Plane Spacing = 2. Leave all other parameters at the default values. 
Select OK. 

If you zoom in to the access drifts, you will notice that face plates are now 
displayed at the upper end of each cable. For more information about the 
Plain Strand Cable model see the RS2 Help system and references. 

Select F2 to Zoom All. You have now defined all the necessary material 
and bolt properties. We will now proceed to the final part of our 
modeling, the assigning of the properties and staging sequence. 
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Assigning Properties 

Select: Properties  Assign Properties 

The Assign Properties dialog allows us to assign the properties we 
defined to the various elements of our model. In conjunction with the 
Stage Tabs at the bottom left of the view, it also allows us to assign the 
staging sequence of the excavations and support. 

 In the first stage, we will assign the ore properties, and also excavate 
the bottom section of the stope, and the three access drifts. 

 In the second stage we excavate the middle section of the stope. 

 In the third stage we excavate the top section of the stope. 

 In the fourth stage, we backfill the entire stope. 

Assign Materials 

1. Make sure the Stage 1 tab is selected (at the bottom left of the view).  

2. Make sure the Materials option is selected at the top of the Assign 
dialog. 

3. Select the “ore” material in the Assign dialog. (Notice that the 
material names are the names you entered when you defined the 
three materials – i.e. rock mass, ore and backfill). 

4. Click the left mouse button in the orebody zones above and below the 
excavation, as well as the two upper sections of the stope. Notice that 
these elements are now filled with the colour representing the ‘ore’ 
property assignment. 

5. Select the “Excavate” button in the Assign dialog. 

6. Place the cursor in the bottom section of the stope and click the left 
mouse button. Notice that the elements in this zone disappear, 
indicating that they are ‘excavated’. 

NOTE: since we defined the “rock mass” properties using the first 
material in the Define Materials dialog, the “rock mass” properties do not 
need to be assigned by the user. The properties of the first material in the 
Define Materials dialog are automatically assigned to all elements of the 
model. Therefore the rock mass, on either side of the orebody, is already 
assigned the correct properties, and it is not necessary for the user to 
assign properties. 

Since the access drifts are so small, we’ll have to zoom in so we can 
accurately select them for excavating. 

 

Stage 1 – material 
assignment and 

excavation of bottom 
section of stope and 

access drifts 
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Select: View  Zoom  Zoom Excavation 

Now press the F5 function key twice to zoom in a bit closer. F5 is 
equivalent to using the Zoom In option. You can also rotate the mouse 
wheel to zoom in or out. 

Again, notice the faceplates which appear at the ends of the cable bolts at 
the access drifts we want to excavate. 

7. You should still be in “Excavate” mode (if not, select the “Excavate” 
button in the Assign dialog.) 

8. Place the cursor in each of the three access drifts, and left click to 
excavate them. 

9. Select the Stage 2 tab. 

10. Place the cursor in the middle section of the stope and click the left 
mouse button, and the elements will disappear. 

11. Select the Stage 3 tab. 

12. Place the cursor in the top section of the stope and click the left 
mouse button, and the elements will disappear. 

13. Select the Stage 4 tab. 

14. Select the “backfill” material in the Assign dialog. 

15. Click in each of the three sections of the stope, and the elements will 
reappear, with the colour representing the ‘backfill’ property 
assignment. 

16. You are now finished assigning materials. As an optional step, select 
each Stage Tab, starting at Stage 1, and verify that the excavation 
staging and material property assignment is correct. 

Assign Bolts 

Since we defined our bolt properties with the first bolt property type 
selected in the Define Bolt Properties dialog, we don’t have to assign 
properties (since they are automatically assigned), but we do have to 
assign the staging sequence of the bolt installation. 

1. At the top of the Assign dialog, select the Bolts option from the drop 
down combo box. 

2. Select the Stage 2 tab. 

3. Select the “Install” button in the Assign dialog. 

Stage 2 – excavation of 
mid-section of stope. 

Stage 3 – excavation of 
top-section of stope. 

Stage 4 – backfill of entire 
stope. 
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4. Use the mouse to select the middle 4 set of bolts. Right click and 
select Done Selection.  

5. Select the Stage 3 tab. 

6. Use the mouse to select the top 4 set of bolts. Right click and select 
Done Selection. 

That is all that is required, the bolts should now be installed at the 
correct stages. Verify your input – when bolts are NOT installed at a 
given stage, they are displayed in a lighter shade of colour. 

7. Select the Stage 1 tab. Only the lower set of four bolts should be 
installed. 

8. Select the Stage 2 tab. Both the lower and middle sets of bolts should 
be installed. 

9. Select the Stage 3 tab. All 12 bolts should now be installed. 

So we see that the effect of Step 4 above, was to install the middle set of 
bolts at Stage 2 (and all subsequent stages). The effect of Step 6 was to 
install the top set of bolts at Stage 3 (and all subsequent stages).  

Close the Assign dialog, and press F2 to Zoom All. 

You have now completed the modeling phase of the analysis. The model 
should appear as in the following figure. 

 

Finished model – RS2 Material & Staging Tutorial 
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Compute 

Before you analyze your model, save it as a file called matstg.fez. 

Select: File  Save 

Use the Save As dialog to save the file. You are now ready to run the 
analysis. 

Select: Analysis  Compute 

The RS2 Compute engine will proceed in running the analysis. Since we 
are using Plastic materials and bolts, the analysis may take a bit of time, 
depending on the speed of your computer. 

When completed, you will be ready to view the results in Interpret. 

Interpret 

To view the results of the analysis: 

Select: Analysis  Interpret 

This will start the RS2 Interpret program. 

Viewing Stages 

By default, you will always see the Stage 1 results when a multi-stage 
model is opened in Interpret. 

Viewing results at different stages in RS2 is simply a matter of selecting 
the desired stage tab at the lower left of the view. 

 

Sigma 1 

Let’s first zoom in.  

Select: View  Zoom  Zoom Excavation 

You are now viewing the Sigma 1 Stage 1 results. Select the Stage 2, 3 
and 4 tabs and observe the changing stress distribution. 

TIP: you can also use the Page Up / Page Down keys to change the 
viewing stage. 
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Toggle on the principal stress trajectories, using the button provided in 
the toolbar. Again select the stage tabs 1 to 4, and observe the stress flow 
around the excavation. 

If you want to compare results at different stages on the same screen, it 
can easily be done as follows. 

1. Select WindowNew Window TWICE, to create two new views of the 
model. 

2. Select the Tile Vertically button in the toolbar, to tile the three views 
vertically. 

3. Select Zoom Excavation in each view. 

4. Select the Stage 1 tab in the left view, the Stage 2 tab in the middle 
view, and the Stage 3 tab in the right view. 

5. Display the stress trajectories in each view. 

6. Hide the legend in the right and middle views (use View  Legend 
Options, or right-click on a Legend and select Hide Legend). 

7. Right-click in any view and select Contour Options. Click in each 
view, and select Auto-Range (all stages), to ensure that the same 
contour range is used for all stages. Close the Contour Options dialog. 

Your screen should appear as shown below. 

 

Sigma 1 contours, stages 1, 2 and 3. Principal stress trajectories are 
displayed. 
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Strength Factor 

While we have the three views displayed, let’s look at the Strength Factor 
contours. 

 

1. Display the Strength Factor in each view. 

2. Toggle Stress Trajectories OFF, and Yielded Elements ON, using 
the Display toolbar buttons, in each view. 

Observe the development of strength factor and yielding around the 
excavation. Note that: 

 The orebody has different strength factor contours than the 
surrounding rockmass, since we assigned it weaker strength 
parameters than the rockmass.  

 Most of the yielding is in the back and floor of the stope (i.e. in the 
orebody), although there is yielding in the rockmass as well. 

 

Strength factor contours and yielded elements 

Let’s view the model full screen again. Maximize one of the views (it 
doesn’t matter which one). Re-display the legend if necessary (View  
Legend Options), and select the Stage 3 tab, if necessary. 

Zoom in to get a closer look at the yielded elements in the stope back. 

Select: View  Zoom  Zoom Window 
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Enter first window point[esc=quit]: 0 100 
Enter second window point[esc=quit]: 50 60  

You will see that there are actually two symbols used for the yielded 
element markers – failure in shear is indicated by an  marker, and 
failure in tension is indicated by a  marker. This is indicated in the 
Legend. If tensile failure is accompanied by shear failure, the symbols 
overlap. 

Display the mesh by selecting the Elements button in the toolbar. Note 
that for 6-noded triangles, the Yielded Element symbols occur at the mid-
side element nodes. 

 

Strength Factor contours and yielded elements, Stage 3.  

As an optional step, use the arrow keys (up / down / left / right), to pan 
the model around the view. View the contours and yielded elements 
around the entire excavation. You can also pan by holding down the 
mouse wheel and moving the mouse. 

Toggle off the Mesh and select Zoom All. Select the Stage tabs 1 to 4, and 
observe the strength factor contours on the whole model. 

Toggle off the Yielded Elements. 
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Displacement 

Now look at the total displacements. 

Select:  

Select the Stage 1 tab. The maximum total displacement for Stage 1 is 
about 22 mm, as indicated in the status bar. 

Maximum Total Displacement = 0.0219 m 

Select the Stage 2 tab. 

Maximum Total Displacement = 0.0286 m 

Select the Stage 3 tab. 

Maximum Total Displacement = 0.0347 m 

Select the Stage 4 tab. 

Maximum Total Displacement = 0.0361 m 

The Stage 3 and Stage 4 maximum displacements are almost identical. 
Thus far we have not discussed the Stage 4 results. This is discussed in 
the next section. 

Zoom in again. 

Select: View  Zoom  Zoom Excavation 

Right-click the mouse and select Display Options. 

In the Display Options dialog, select the Stress tab, toggle on Deform 
Boundaries, enter a Scale Factor of 100 and select Done. 

Select the Stage tabs 1 to 4 again, and observe the displacement contours 
with the deformed boundaries displayed. 

The deformed boundaries graphically illustrate the inward movement of 
the excavation boundaries. It is also interesting to observe the shifting of 
the access drifts towards the hangingwall – if you did not notice this, 
select the Stage tabs 1 to 3 and observe the displaced outlines of the 
access drifts. 

Note: the Deform Boundaries option is also available in the toolbar. 
However, if you want to customize the scale factor (as we did here, with a 
scale factor = 100, you will have to use the Display Options dialog. 
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Total displacement contours, third stage. Deformed Boundary option 
toggled ON, Scale Factor = 100 

To prepare for the last part of the tutorial, let’s close two of the views we 
created. First tile the views with the Tile option in the toolbar. Then close 
two of the views. Then maximize the remaining view, and select Zoom 
Excavation, if necessary. Turn off the Deformed Boundaries display by 
selecting the Deformed Boundaries toolbar button. 

Stage 4 

Remember that in the fourth stage of this model we backfilled the entire 
stope with a material having representative backfill properties. Except 
for this, nothing else was changed. 

Practically speaking, the backfill has no effect on the results for this 
model, compared to the third stage results. It is left as an exercise for the 
user to verify that the contour plots in the third and fourth stage are 
essentially identical. 

 The purpose of the backfill in this tutorial was to demonstrate how it 
could be modeled. A practical use of backfill modeling would be a 
staged model with several excavations that were excavated and then 
backfilled in sequence. In this case, the stiffness of the backfill would 
serve to limit displacements in the backfilled excavations. However, 
that is beyond the scope of this tutorial, and is left for the user to 
demonstrate for themselves. 
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 One final note – remember we specified the Initial Element Loading 
for the backfill material as Body Force Only. This effectively gives the 
backfill an active force resisting the excavation deformation, in 
addition to the passive material stiffness. However, compared to the 
field stress in this model, this body force is negligible and its effects 
on the model are minimal. If we were dealing with a surface 
excavation and gravity field stress, then the body force loading would 
be more significant. (If we had specified the Initial Element Loading 
as ‘None’, then only the backfill stiffness would resist deformation.) 
See the RS2 Help system for more information about Initial Element 
Loading. 
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Bolts 

Now let’s see what’s going on with our bolts. They don’t seem to have any 
obvious effect on the stress or strength contours, so let’s see what other 
information we can gather, using the Graph Bolt Data option. First, 
select the Stage 3 tab. 

Select: Graph  Graph Bolt Data 

Pick bolts to graph[enter=done,*=all, esc=quit]: use the mouse 
to select the lower set of 4 bolts  

 
When the four bolts are selected (they are highlighted by a dotted line 
when selected), right-click the mouse and select Graph Selected, and you 
will see the following dialog: 

 

In the Graph Bolt Data dialog, select Create Plot, and a graph of Axial 
Force for the selected bolts will be generated. 

Now repeat the above procedure for the middle and the top sets of four 
bolts, to generate two more graphs. 

Let’s tile the graphs we have created, so that we can view them all on one 
screen.  

Select: Window  Tile Vertically 
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On each graph you will notice a legend, with a bolt number and a stage 
number. Right click on the model and select Display Options. Under 
Support, turn on Bolt Numbers and close the dialog. You will notice 
numbers have been assigned to each bolt. The bolt numbers on the model 
correspond to the bolt numbers on the graphs, allowing you to identify 
the bolts. 

 

Axial force in cables vs. distance along each cable. 

Furthermore, the numbers also identify the end of each bolt and 
therefore the end of each curve. 

The start of each curve therefore represents the end with the face plate, 
at the access drifts. An important point to remember when you are 
installing bolts with face plates between two excavations – the first 
point of each bolt must be the end with the face plate. You must remember 
this when you create the bolt geometry using the Add Bolt option or DXF 
import. 

Also notice on the plots that the peak capacity of the bolts (0.1 MN) is 
indicated by a horizontal line. The force in all bolts is well below this line, 
indicating that there is no yielding in the bolts. 

Let’s verify that there is no yielding in the bolts. Left-click in the model 
view, and select the Yielded Bolts button from the toolbar. In the status 
bar at the bottom left of the screen you will see: 

No yielded bolt elements 

As we expected, no bolts have yielded (if there were yielded bolts, the 
yielded sections would be highlighted with a different colour). 
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While we are looking at bolt data, let’s illustrate one more feature, the 
ability to plot data from multiple stages on a single graph. First, 
maximize the model view (if you are still looking at the tiled view of all 
the graphs). 

Select: Graph  Graph Bolt Data 

Pick bolts to graph[enter=done,*=all, esc=quit]: select bolt #4 
(the fourth bolt from the bottom of the model).  

 
Right-click the mouse and select Graph Selected as before, except this 
time select the first three stages to plot, using the checkboxes. 

 

In the Graph Bolt Data dialog, select Stages 1, 2 and 3 to plot. Select 
Create Plot, and the Axial Force at stages 1, 2 and 3 for the selected bolt 
will be plotted. 
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Axial force in Bolt 4 at Stages 1, 2 and 3. 

In this case, the axial force in the bolt, near the face plate, increases from 
stage 1 to stage 2, and does not change significantly from stage 2 to stage 
3. 

To summarize the bolt data interpretation, it is always important to look 
at the effect of the excavation on the bolts, and not just the bolts on the 
excavation. In many cases, the bolts will have little effect on the contour 
plots (stress, strength, displacement), but will nonetheless be taking a 
substantial load. Unless the bolts are installed in a zone of yielding with 
large displacements (see the RS2 Support Tutorial) this will often be the 
case. 

Examining the load in the bolts allows you to design bolt support by 
varying bolt parameters (diameter, etc) to obtain optimal stress in the 
bolt system.  

Let’s demonstrate one more interactive feature of the bolt graphs. Tile 
the views. Notice that as you hover the mouse cursor over points on the 
bolt graphs: 

 a popup box displays the bolt data corresponding to that point 

 on the model view, you will see a red circle displayed on the exact 
bolt element corresponding to the point on the bolt graph, as 
shown in the following figure. 

Place the mouse cursor over different points on the bolt graph and 
observe the location of the red circle on the model view. 
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Interactive red circle corresponding to selected data point on bolt graph. 

Close the bolt graph views and maximize the model view. 

Differential Results 

In the Interpret portion of this tutorial, we always used a Reference 
Stage = 0. Differential results between any two stages can be viewed by 
setting the Reference Stage > 0 in the Stage Settings dialog. For example: 

Select: Data  Stage Settings 

 

Set the Reference Stage to 1 and select OK. 
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Notice that the Stage Tabs now allow you to view results relative to the 
reference stage you just entered. The ( r ) in the stage tabs indicates that 
you are viewing differential results with respect to a reference stage. 

 

We will not explore differential results further in this tutorial, but the 
user is encouraged to explore this on their own. See the RS2 Help system 
for information about how to interpret differential results. 

Log File and Load Step Plot 

Before we conclude this tutorial, let’s examine the Log File which is 
created during a RS2 stress analysis, and the Load Step plot. 

Select: Analysis  Log File 

A summary of the number of load steps at each stage, and the number of 
iterations and final tolerance at each load step, is displayed in its own 
view. Scroll down to view all of the information. 

After a plastic analysis, it is a good idea to check the log file to make sure 
that the solution converged within the specified tolerance. For this 
example, the final calculated tolerance is less than 0.001 for each load 
step, indicating convergence within our specified tolerance. The 
tolerance, number of load steps, and maximum number of iterations, can 
all be user specified in the Project Settings dialog when you create the 
model. 

Close the log file view. 

Now view the Load Step Plot, which graphically illustrates the data in 
the Log File. 

Select: Analysis  Load Step Plot 
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Load Step plot for stress analysis 

The Load Step Plot plots the maximum displacement at each load step, 
for each stage. 

That concludes the ‘Materials and Staging’ tutorial. 

 




